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1. Introduction 
PLCMotion is an interactive graphic tool for teaching, designing, simulating and executing automatic 
control applications for the Allen BradleyTM SLC 500TM, MicroLogixTM 1000, and MicroLogixTM 1100 
Programmable Logic Controller Systems. The program is suitable for use at the tech-ed and higher 
education levels, according to the Standard I.E.C. 1131-3 Instruction List of the International Electrical 
Committee. (Geneva, Switzerland). 

PLCMotion allows you to use almost all the features of the following PLC input contacts: 

One shot pulses, output coils, bit-flags, and 28 instructions/boxes (e.g., timers, counters, arithmetic or 
logic functions, move, shifts, sequencers, etc.). 

The PLCMotion system contains: 

 PLC Editor (to edit ladder diagrams):  
Compatible with the Allen Bradley SLC 500 / MicroLogix 1000 / MicroLogix 1100 

 A Translator to I.E.C.1131-3 Instruction List for simulation 

 An interactive Simulator, in a graphic display. 

 An Emulator to run real applications. 
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2. Starting PLCMotion 

2.1. SYSTEM REQUIREMENTS 

PLCMotion minimum PC requirements are: 

 Pentium 4 Dual Core @ 2.0 GHz processor 

 512 MB RAM 

 DVD/CD ROM drive 

 Windows 7 32 bit SP1 

 Hard drive with at least 1 GB of free disk space 

 Super VGA or better graphics display, minimum 256 colors 

 Fully Windows compatible LAN interface card 

 Separate RS232 port or USB port with RS232 – USB adapter on the PC 

 
Note 

Supported Windows versions:  

 Windows 7 Home Premium/Enterprise/Professional/Ultimate 32/64 bit SP1 

 Windows 8/8 Pro/8 Enterprise 

 Windows 8.1/ 8.1 Pro/8.1 Enterprise 

 Windows 10 Pro/Enterprise/Education 

PLCMotion maximum PC requirements are: 

 Intel Core i7-4770 CPU @ 3.40GHz processor 

 8.00 GB RAM 
Note: Your operating system might have additional hardware requirements. 

2.2. INSTALLING THE SOFTWARE 

PLCMotion software is supplied on a CD. The software is copy-protected. 

To install the software: 

1. If you are about to reinstall the software or install a newer version to an existing PLCMotion 

directory, it is recommended that you backup any existing user-created files before you begin 

the installation. It is also recommended that you remove the previous PLCMotion installation by 

means of the Uninstall utility included with the software. 

2. Close any applications that are open before you begin the installation.  

3. Insert the CD into the CD-ROM drive. The installation should begin automatically. If it does not, 

run setup.exe from the CD-ROM \Install folder. 
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4. Follow the instructions that appear on the screen. Note the following: 

 You will be asked to select a PLC Type. Select the type of controller you will be using. This 

selection cannot be changed after installation except by reinstalling PLCMotion. 

 

 By default, the software is installed to the folder C:\Intelitek\PLCMotion. During the 

installation process you have the option to change this. It is not recommended that you do 

so. 
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2.3. UNINSTALLING PLCMOTION 

To uninstall PLCMotion: 

1. Navigate to: 

 For Windows 10: Right-click the Start button, then select Programs and Features. 

  For Windows 8: Press Windows Key+X to display the Tools Menu, and then select Programs 

and Features. 

 For Windows 7: Windows Start Menu | Control Panel | Programs | Uninstall a Program. 

2. Select PLCMotion. 

3. Click Uninstall. 

4. Follow the instructions that appear on the screen. 

2.4. ACTIVATING THE SOFTWARE 

From the PLCMotion program group in your Windows Start menu, select any of the following: 

 

PLC Editor Activates the PLC Editor. For further information on 
how to create a ladder using the PLC Editor see 
Chapter ‎3. 

 

PLC Online 
Control 

Activates PLC Online Control. For more information see 
Chapter ‎4. 

 

HMI PLC Line Activates the PLC Simulator with the  
HMI PLC Line interface. This configuration allows you to 
run a previously programmed ladder and observe it in 
the HMI PLC Line panel simulation. For more 
information see section ‎5.2. 

 

HMI Gate Activates the PLC Simulator with the HMI Gate 
interface. This configuration allows you to run a 
previously programmed ladder and observe it with the 
simulation of a PLC-controlled Gate. For more 
information see section ‎5.3. 

 

HMI IceCream Activates the PLC Simulator with the  
HMI IceCream interface. This configuration allows you 
to run a previously programmed ladder and observe it 
with the simulation of a PLC-controlled ice cream filling 
line. For more information see section ‎5.4.  
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2.5. QUITTING THE SOFTWARE 

To close the PLCMotion modules, refer to the specific chapter for the module you want to quit. 

 

 

3. PLC Editor 

3.1. OVERVIEW 

3.1.1. Activating PLC Editor 

 

To open PLC Editor, do one of the following: 

 Double click the PLC Editor icon from the PLCMotion program group 
folder. 
OR 

 From the Start menu, select Programs | PLCMotion | PLC Editor. 
The PLC Editor window opens: 

: 
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3.1.2. Quitting PLC Editor 

To exit PLC Editor: 

1. Select File | Exit. 

2. Click Yes in the Exit dialog box. 

 

3.2. PLC EDITOR MENUS 

3.2.1. File Menu 

 

The file menu contains the usual Windows functions that allow you to load and 
save files, and exit the software. In addition, you may change the properties and 
view the instruction list through this menu. 

 

New Opens a new file called NEWFILE, for a new ladder 
diagram. 



 

‎3 PLC Editor   © 2017 Intelitek Inc 

‎3.2 PLC Editor Menus 7 All rights reserved 

 

 

Open The Open dialog box opens. 

 

To open an existing ladder diagram from the dialog 
box: 

1. Select the file you want to open. 

2. Click OK. 

 

Save Saves the current ladder diagram. 

The first time you save a ladder diagram file, use the 
Save As command and assign a file name. 

 Save As Saves the active ladder diagram under a new file name. 
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 Properties Opens the File Properties dialog box. 

 

You may enter the author of the file, and make 
comments. You can also view the following 
information: 

 File 

 Directory (Path) 

 Time last opened 

 Size of file 
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 Instruction List Opens the Text File dialog box. This displays the name 
and type of the active ladder diagram. Click on Display 
to see a list of all the instructions in the active ladder 
diagram. 

 Exit Closes the PLC Editor. 

3.2.2. Edit Menu 

 

The Edit menu contains the commands that allow you to edit ladder diagram 
files. 

 

Cut Deletes selected texts or objects in the ladder diagram. 
To delete an object or rung: 

1. Select Edit | Cut. 

OR 

Click the Cut button. 

2. Click the activation button    of the rung with 

the object to be deleted.                                         

3. Click on the object to be deleted. 

The object is deleted. 

To delete an empty rung, follow steps 1 and 2 above. 
The rung is deleted. 

 

Paste Pastes the contents of the clipboard into the ladder 
diagram. 

To paste rungs form the clipboard into a ladder 
diagram: 

1. Click on the activation button of the rung above 

where you want to insert the clipboard 

selection. 
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2. Select Edit | Paste. 

The selection is inserted after the selected rung. 

The rungs are automatically renumbered. 
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Undo Undoes the last operation. 

To undo an editing operation, do the following. 

 Select Edit |Undo. 
OR 

 Click the Undo button. 
The last operation is undone. 

 

Find Opens the Find dialog box.  

To find addresses and comments in a ladder diagram: 

1. Select Edit | Find. 

2. From the dialog box, select the desired text. 

 

3. Click OK. 

The selected text will be highlighted. The rung 

with the text will be active. 

 

Find Next Finds the next occurrence of the selected text. 

Use this command after using the Find command. This 
will automatically locate the next occurrence of the text 
located with the Find command. 
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 Replace Opens the Replace Text dialog box: 

 

To replace addresses in a series of rungs: 

1. Select Edit | Replace. 

2. Type the address you want to replace in the 

Text to Find field. 

3. Type the new address in the New Text field. 

4. From the Select field in the dialog box, select 

the rung number where the address is to be 

replaced. 

5. Click Replace. 

 Go To  Opens the Go To dialog box. 

To choose a rung number directly: 

1. Select Edit | Go to Rung Number. 

The Go To dialog box opens. 

 

2. From the dialog box, select the desired rung 

number. 

3. Click OK. 

The selected rung appears and is selected. 

You can also select a rung by scrolling through 

the ladder diagram, and selecting the ladder’s 

activation button. 
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3.2.3. Ladder Menu 

 

The ladder menu contains the commands needed to edit and create ladders. 

 

Relay Activates the add relay function. To add a relay to a 
ladder diagram: 

1. Select Ladder | Relay. 

OR 

Click on the Add Relay button. 

A submenu with a list of instructions opens. 

2. Select the type of instruction you wish to use. 

3. Click on the activation button of the rung to add 

the relay. 

4. Click anywhere on the left side on the rung to 

add the relay. 

The Object Properties dialog box opens. 

 

5. Enter the variable address in the Address field 

by using the on-screen keyboard. 

6. Enter a comment or description in the comment 

field (optional). 

7. Click OK to insert the relay on the rung. 
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Coil Activates the add coil function. To add a coil to a ladder diagram: 

 Select Ladder | Coil. 
OR 

Click on the Add Coil button. 

A submenu with a list of instructions opens. 

1. Select the type of instruction to add to the ladder from 

the submenu. 

2. Click on the activation button of the rung to add the coil. 

3. Click on the appropriate section of the rung to add the 

box. 

The Object Properties dialog box opens. 

4. Enter the variable address in the Address field by using 

the on-screen keyboard. 

5. Enter a comment or description in the comment field 

(optional). 

6. Click OK to insert the coil on the rung. 

 

Box Activates the Add Box function. To add a box to a ladder diagram: 

1. Select Ladder | Box. 

OR 

2. Click on the Add Box button. 

A submenu with a list of function boxes opens. 

3. Select the type of function box to add to the ladder from 

the submenu. 

4. Click on the Activation button of the rung to add the box. 

5. Click on the appropriate section of the rung to add the 

box. 

A dialog box with the name of the selected function 

opens. 

 
Enter the information in the appropriate field using the 

on-screen keyboard. For more information on how to 

enter information in the function dialog boxes, see the 
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sectionCreating a Ladder with PLC Editor. 

6.  Click OK to insert the box on the rung. 

 

Line Inserts vertical and horizontal lines to connect elements in the 
ladder. 

To add a line to a ladder: 

1. Select Ladder | Line. 

Or  

2. Click on the Line button. 

3. Click on the Activation button of the rung to connect the 

line. 

4. Click on the appropriate part of the grid above or below 

the selected rung to connect the elements. 

You can select the Show Grid command (see below) to 

help in placing the lines. 

 

Object Properties Opens the Object Properties dialog box or a function box dialog 
box of a selected object. This allows you to change any 
information entered for a selected object. 

To edit information for an object: 

1. Select Ladder | Object Properties. 

OR 

Click the Object Properties button. 

2. Click the Activation button of the rung with the object to 

be edited. 

3. Click on the object to be edited. 

The Object Properties dialog box, or a function box dialog 

box opens. 

4. Edit the appropriate fields using the on-screen keyboard. 

5. Click OK. 
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Show Grid Shows the active grid area in a ladder diagram. 

To view the active grid area in a ladder: 

 Select Ladder | Show Grid. 
OR 

 Click the Show Grid button. 
The grid appears in the ladder diagram. 

 

 

Add Rung Activates the add rung function. To add a rung do the 
following: 

1. Select Ladder | Add Rung. 

OR 

Click on the Add Rung button. 

2. Click on one of the Rung Activation buttons. 

A rung will be added above the rung you selected. 

 

 

 

Compile Compiles and converts the ladder diagram into an Allen 
Bradley ASCII import file, or a simulation Instruction List. 

To compile a completed ladder diagram: 

1. Select Ladder | Compile. 

OR 

Click on the Compile button. 

2. If you are prompted to save the ladder diagram, 

click yes. 

A check mark will appear on the button if the 

ladder was compiled successfully. If the ladder 

was not compiled successfully, an “X” will appear 

on the button, and a red dot will appear on the 

grid where the first error occurs.  
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For more information on compiling a ladder 

diagram, see the section Creating a Ladder with 

PLC Editor. 

3.2.4. Help Menu 

 

The Help menu contains commands for viewing the software version 
information as well as the software licensing options.    

 About  Opens the About PLC Editor dialog box containing 
the current software version information.    

 Registration  Opens the Registration dialog box enabling you to 
perform various registration options, such as 
obtain and retrieve your software license by 
Intelitek’s web site, e-mail, or fax or phone.         

3.3. CREATING A LADDER WITH PLC EDITOR 

The Ladder menu and the button tool bar are used for ladder editing in PLCMotion. 

To begin editing a ladder diagram, select File | New or File | Open. 

3.3.1. Editing Tools 

To edit a rung of the ladder: 

1. Click the Activation button next to the rung to be edited. 

2. Click on Relay (or other) button. 

3. Click on the rung where the input or output is to be placed. 

4. Enter information in the appropriate dialog box. 

3.3.2. Using the Activation Button 

 Activation Button Activates the corresponding rung. 

Clicking the Activation button a second time will 
deactivate the corresponding rung. 

Editing a rung is possible only after it is activated. Click 
on the activation button for the rung to become active. 
An active rung is bold. 
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3.3.3. Using the Submenus 

3.3.3.1. Relay Contact Submenu 
 

The Relay submenu allows you to enter relays or inputs 
into a rung. 

 

These relays are translated by the Allen Bradley 
controller as instructions. 

In order to insert any input instruction, you must give it 
an address or other information. 

To enter an address or other information, use the on-
screen keyboard in the appropriate dialog box. See the 
section Using the PLC Editor Dialog Boxes. 
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 Normally Open 
contact 

Inserts a normally open input into a rung. You must give 
the input an address. You may also enter a comment. 

This is also referred to as the Examine if Open (XIO) 
instruction. 

 Normally Closed 
contact 

Inserts a normally closed input into a rung. You must 
give the input an address. You may also enter a 
comment. 

This is also referred to as the Examine if Closed (XIC) 
instruction. 

 Label Inserts a label into a rung. A label marks a place a place 
in a rung as a reference for an output Jump. You must 
give the label an address. You may also enter a 
comment dialog box. 

 One Shot Rising Inserts the One Shot Rising (OSR) instruction. This 
instruction generates a short pulse upon activation of 
the instruction. The OSR instruction is true only for one 
cycle. It is not true again until the conditions for the 
instructions preceding it change. 

 ESC Cancels the Relay Contact submenu without adding and 
input. 

 
See Chapter ‎6 for more information on the above instructions. 

3.3.3.2. Coil Contact Submenu 
 

The Coil submenu allows you to enter coils or outputs 
into a rung. 

 

These coils are translated by the Allen Bradley 
controller as instructions. 

See Chapter ‎6 for more information. In order to insert 
any output instruction, you must give it an address or 
other information. 

To enter an address or other information, use the on-
screen keyboard in the appropriate dialog box. See the 
section Using the PLC Editor Dialog Boxes. 

 Coil Output contact Inserts a Coil output contact into a rung. You must give 
the output an address. You may also enter a comment. 
This is also referred to as the Output Energize (OTE) 
instruction. 
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 Output Latch  Inserts an output latch into a rung. You must give the 
output an address. You may also enter a comment. 

 Jump to Label Inserts a Jump to Label instruction into a rung. The 
Jump instruction causes the program to jump to the 
rung with the specified label. 

 Reset a 
Timer/Counter 

Inserts a reset timer or counter instruction into a rung. 
This instructs the program to restart a specified timer or 
counter to zero. 

 Output Unlatch  Inserts an output unlatch into a rung. You must give the 
output an address. You may also enter a comment.  

 Master Control Inserts the master control instruction into a rung. This 
instruction instructs the program to skip a specified 
rung. 

 ESC Cancels the Coil Contact submenu without adding an 
output. 

 
See Chapter ‎6 for more information on the above instructions. 

3.3.3.3. Box Submenu 
 

The Box submenu allows you to enter special 
instructions into a rung. 

 

These instructions are inserted inside of a function box. 

To program an instruction, use the on-screen keyboard 
in the appropriate dialog box. See the section Using the 
PLC Editor Dialog Boxes for more information. 

 TON Inserts the [Timer On Delay] instruction into the 
function box. 

 TOF Inserts the [Turn Off Delay] instruction into the function 
box. 

 RTO Inserts the [Retentive Timer On Delay] instruction into 
the function box. 

 CTU Inserts the [Count Up] instruction into the function box. 

 CTD Inserts the [Count Down] instruction into the function 
box. 

 EQU Inserts the [Equal] instruction into the function box. 

 NEQ Inserts the [Not Equal] instruction into the function box. 
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 MEQ Inserts the [Masked Comparison for Equal] instruction 
into the function box. 

 GEQ Inserts the [Greater Than or Equal To] instruction into 
the function box. 

 LEQ Inserts the [Less Than or Equal To] instruction into the 
function box. 

 GRT Inserts the [Greater Than] instruction into the function 
box. 

 LES Inserts the [Less Than] instruction into the function box. 

 ADD Inserts the [Addition] instruction into the function box. 

 SUB Inserts the [Subtraction] instruction into the function 
box. 

 MUL Inserts the [Multiply] instruction into the function box. 

 DIV Inserts the [Divide] instruction into the function box. 

 AND Inserts the [Logical AND Operation] into the function 
box. 

 OR Inserts the [Inclusive OR operation] into the function 
box. 

 XOR Inserts the [Exclusive OR Operation] into the function 
box. 

 NOT Inserts the [Logical NOT Operation] into the function 
box. 

 NEG Inserts the [Negate] instruction into the function box. 

 CLR Inserts the [Clear] instruction into the function box. 

 MOV Inserts the [Move] instruction into the function box. 

 MVM Inserts the [Masked Move] instruction into the function 
box. 

 
BSR Inserts the [Bit Shift Right] instruction into the function 

box. 

 BSL Inserts the [Bit Shift Left] instruction into the function 
box. 

 
See Chapter ‎6 for more information on the above instructions. 
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3.3.4. Using the PLC Editor Dialog Boxes 

Instructions in PLCMotion must have addresses or other information. A dialog box appears each time an 
instruction is inserted into a rung. Each dialog box includes fields to enter information. Data is entered 
into the fields using an on-screen keyboard found in the dialog box. 

3.3.4.1. Assigning Addresses 

 

The Object Properties, or an instruction specific dialog box opens when you insert an instruction into a 
ladder diagram. 

To assign an address or other information: 

1. Click in the Address field. 

2. Enter an address using the on-screen keyboard, or your computer keyboard. 

 Enter the input or output word number. 

 Enter a slash (/). 

 Enter the bit number. 

3. Click on the comment field. 

4. Use the on-screen keyboard, or your computer keyboard to enter a comment. (Optional). 
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Each word begins with a file type and number separated by a colon. The following table describes the 
file types used in PLCMotion. 

File # or File Type File Description 

O: Output. This file stores the state of an output. 

I: Input. This file stores the state of an input. 

S2: Status. This file stores information useful for troubleshooting. 

B3: Bit. This file contains internal relay logic. It is used for bit instructions other 
than inputs or outputs. For example, the One Shot Rising (OSR) instruction. 

T4: Timer. This file contains timer accumulators and preset values. 

C5: Counter. This file contains the counter accumulators and preset values. 

R6: Control. This file contains the length, pointer position and status for specific 
instructions. 

N7: Integer. This file is used to store numeric values. 

Each of these file types is available by clicking a button found in the on-screen keyboard. 

When selecting the file types, T4, C5 or R6, an internal bit must be selected. Select an internal bit from 
the Bit box found in the middle of the dialog box. 

The following are the internal bit instructions found in PLCMotion: 

Internal Bit Description Use With File Type: 

CD Count down C5 

CU Count up C5 

DN Done T4, C5, R6 

EN Enable T4, R6 

ER Error R6 

FD Found R6 

OV Overflow C5 

TT Timer Active T4 

UL Unloaded unit R6 

UN Underflow C5 

3.3.4.2. Entering Information for Instructions in Function Boxes 

Instructions in function boxes also have addresses. See the section, Assigning Addresses for more 
information. 

Depending on the specific instruction, additional information is also entered into specific fields (See 
dialog box examples below). This information varies. Therefore, each instruction has a different dialog 
box. The following are examples of some of the dialog boxes used to enter this information. 
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See Chapter ‎6 for further information on specific instructions. 
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4. PLC Simulator and PLC Online Control 

4.1. OVERVIEW 

Both PLC Online Control and PLC Simulator allow you to view PLC ladder diagrams created with PLC 
Editor. 

PLC Online Control is used to run a PLC ladder diagram on a PLC logic controller connected to the 
PLCLine panel. 

PLC Simulator is used to run a PLC ladder diagram on a simulated HMI (Human-machine interface) panel 
displayed on your screen, without the need for a PLC logic controller or the PLCLine panel. 

Both programs work almost identically, and are explained in the sections below. 

4.1.1. Activating PLC Online Control  

To open the PLC Online Control window: 

 From the Start menu, select Programs | PLCMotion | PLC Online Control. 
The PLC Online Control window opens at the top of the screen. The PLC logic controller you 

selected during installation is indicated in the window title bar. 
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4.1.2. Activating PLC Simulator 

PLC Simulator is opened automatically when you launch any of the three HMI simulators from the 
PLCMotion program group in your Start menu. 

 

PLC Simulator is also launched from within LearnMate content courses. 

4.1.3. Quitting PLC Online Control / PLC Simulator  

To exit PLC Online Control or PLC Simulator: 

 Select File | Exit. 
OR 

 Press [Alt] F4. 

4.2. RUNNING A LADDER DIAGRAM 

All menu options and toolbar buttons are described in section ‎4.3. This section provides instructions on 
how to open a ladder diagram and run it. The instructions are identical for PLC Online Control and PLC 
Simulator. 

To open a ladder diagram and run it: 

1. Open PLC Online Control or PLC Simulator. 

2. Click File | Open. 

3. Select the ladder diagram to open, and click Open. 

The ladder diagram is displayed. 

4. Click Simulation  and then On-Line . 

The HMI simulation or PLCLine panel should now operate according to the ladder diagram 

loaded.  

For information on how to configure online operation if not functional, see Chapter ‎7. 
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4.3. PLC ONLINE CONTROL / PLC SIMULATOR MENUS 

4.3.1. File Menu 

 

The file menu contains the Windows functions used to open close and print 
files. New files must be created first using PLC Editor. 

 

Open Opens a saved ladder diagram. 

 

Close Closes the active window without exiting the program. 

 Close All Closes all open windows. 

 Print Preview Shows how a file will look when printed. 
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 Print Setup Opens the Page Setup dialog box. Sets margins, paper 
size, page orientation, paper source, and other layout 
options for the active file. 

 

 

Print Opens the Print dialog box. Allows you to print the 
active file. 

 Properties Opens the Properties window. 

 

The properties window has the name of the active 
ladder diagram. It contains the following information: 

 Author 

 Comments 

 I/O list 
 Exit Closes the software, while prompting you to save files. 
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4.3.2. View Menu 

 

The View menu contains the commands for the viewing modes available in PLC 
Online Control / PLC Simulator. 

 
Memory Map Opens a memory map. The memory map shows the 

status of the memory addresses used in the ladder 
diagram. For information on using the Memory Map, 
see Map Menu below. 

 
Ladder Diagram Opens the active ladder diagram when the Memory 

Map is active. 

 
Refresh (In PLC Simulator only) Updates the HMI file when the 

simulator ladder is changed. 

The active ladder diagram must correspond to the 
active HMI module. For more information on using the 
simulator with an HMI module, see Chapter ‎5. 

4.3.3. Simulate Menu 

 

The Simulate menu allows you to choose how to operate the software. You can 
work online with a PLC panel and controller, offline, or in simulation mode. 

 
On-Line Activates PLCMotion communication with a PLC logic 

controller or simulated HMI.  
 
Select this option again to go off-line. 

 
Simulation Activates PLCMotion simulation mode for the PLC logic 

controller or simulated HMI.  

 
Single Step Activates the active PLC ladder instructions one at a 

time. 

 AB PLC Configuration Opens a utility for establishing communication between 
the PC and the PLCLine panel. For more information, 
see section ‎7.3.1. 
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4.3.4. Window Menu 

 

The Window menu allows you to define how the windows containing circuit 
diagrams are displayed on the screen. 

 Cascade The usual Windows control for resizing and layering 
open windows so that each title bar is visible. 

 Tile Horizontal Arranges open windows one above the other. 

 Tile Vertical Arranges open windows side by side. 

4.3.5. Map Menu 

 

The Map menu contains the commands used for viewing a Memory Map. The 
Memory Map shows the status of the memory addresses. The Map menu is 
available only when a Memory Map is open. 

 

 Red, Green Displays the status for each bit by color. The box is red 
when the status is false, and green when the status is 
true. 

 0,1 Displays the status for each bit by number. The box 
displays the number 0 when the status is false, and 
displays 1 when the status is true. 

 Hexidecimal Displays the value of the word in hexidecimal numeric 
form. 

 Decimal Displays the value of the word in decimal numeric form. 

 Octal Displays the value of the word in octal numeric form. 
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4.3.6. Help Menu 

 

The Help menu contains commands for viewing the software version 
information as well as the software licensing options.    

 About  Opens the About PLC Online Control / PLC 
Simulator dialog box containing the current 
software version information.    

 Registration   Opens the Registration dialog box 
enabling you to perform various 
registration options, such as obtain and 
retrieve your software license by 
Intelitek’s web site, e-mail, or fax or 
phone.         

4.3.7. Working with the Memory Map 

The Memory Map displays the status of memory addresses for an active PLC ladder. Each row has 16 
boxes. Each box displays one bit, and each row represents one word. See the above Figure for a 
description of the Memory Map. Placing the mouse on a box displays the address at the bottom of the 
screen. The address values can be manually edited or automatically monitored with the Memory Map.  

4.3.7.1. Manually Changing the Status of Addresses in the Memory Map 

To change the status of a bit: 

 Click on the bit. 

To change the value of a word: 

1. Click on the word value in the second column. 

The Memory Value dialog box will open. 

2. Enter the new memory value in the field. 

3. Click OK. 

4.3.7.2. Automatically Monitoring the Status of Addresses in the Memory Map 

To monitor the status of a PLC program: 

1. Open the Memory Map. 

2. Click the Simulation button or Select Simulate | Simulation. 

The status of the bits will change in coordination with the active PLC ladder. 
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5. Working with HMIs 

5.1. OVERVIEW 

PLC Simulator is used to run a PLC ladder diagram on a simulated HMI (Human-machine interface) panel 
displayed on your screen, without the need for a PLC logic controller or the PLCLine panel. 

For information on how to launch and use PLC Simulator, see Chapter ‎4. 

This chapter describes the HMIs listed in the PLCMotion program group in your Start menu. HMIs that 
are only available through LearnMate courses and not directly through the Windows Start menu are 
described within the courses. 

The input and output addresses used vary depending on which controller is being used. 

5.2. PLC LINE HMI 

The HMI PLC Line, shown in the figure below, is a graphic display of the PLCLine hardware panel. 

5.2.1. Panel Buttons 

The bottom of the HMI PLC Line contains buttons that activate commands used when working with the 
HMI PLC Line simulation. 

 

 

Show All 
Hide All 

Turns the labels on the HMI PLC Line on or off. The 
labels show the addresses of the Panel components. 

This functionality is not available when using the SLC 
500 controller. 

 

 
Reset  Resets the nut on the motor to the initial (left) 

position. 
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5.2.2. I/O Addresses 

Controller Addresses 

SLC 500 

 

MicroLogix 
1000 / 1100 

 

 

 

 



 

‎5 Working with HMIs   © 2017 Intelitek Inc 

‎5.3 Gate HMI 34 All rights reserved 

 

5.3. GATE HMI 

The Gate HMI enables users to simulate ladder diagrams that control an entrance gate, which is opened 
and closed by an electric motor that drives one of the gate's wheels. The electric motor is controlled by 
two push button (PB) switches installed in the gatekeeper's booth: OPEN PB and CLOSE PB. 

Assuming the gate is initially closed, the gate is opened as follows: 

 Pressing the OPEN PB starts the motor, and the gate opens. 

 The gate continues to open, even if the OPEN PB is released. 

 Once the gate is fully open, a sensor is activated and the motor stops. 

The gate-closing procedure is as follows: 

 Pressing the CLOSE PB starts the motor in the opposite direction and the gate begins to close. 

 The gate continues to close, even if the CLOSE PB is released. 

 The motor stops once the sensor detects that the gate is fully closed. 

5.3.1. I/O Addresses 

Controller Addresses 

SLC 500 

 

MicroLogix 
1000 / 1100 
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5.4. ICE CREAM FILLING STATION HMI 

The Ice Cream Filling Station HMI simulates the control of an ice cream filling process.  

The station includes the following components: 

 A filling valve. 

 A cup (to be filled with ice cream). 

 A PB switch that activates the system. 

 Two sensors: 

 Sensor A indicates when a cup is under the valve outlet. 

 Sensor B indicates when the cup is full. 

The simulated control system works as follows: 

1. When an empty cup is placed under the valve outlet (indicated by Sensor A) AND the PB is 

pressed, the ice cream valve is opened. 

2. When the cup is full (indicated by Sensor B), the filling valve closes. 

3. When the ice cream flow is too slow (for example, if the ice cream viscosity is too high), a red 

warning lamp is activated to warn the system operator. 
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5.4.1. I/O Addresses 

Controller Addresses 

SLC 500 

 

MicroLogix 
1000 / 1100 
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6. Allen Bradley (AB™) Controllers 

Instruction List 

6.1. OVERVIEW 

This chapter describes the instructions used for an Allen Bradley controller. For information on how to 
insert instructions into your PLC ladder, see Chapter ‎3. 

6.1.1. Address Organization 

Allen Bradley PLC instruction addresses are made of words. Each word is made up of 16 bits, numbered 
from 0 to 15. Each group of addresses is located in a memory file. Each file contains 256 words, 
numbered from 0 to 255. 

For an explanation of which file types to use with which type of instruction, see Chapter ‎3. 

6.2. INSTRUCTION DESCRIPTIONS 

6.2.1. Relay Type Instructions 

6.2.1.1. OSR: One Shot Rising 

The OSR is a conditional input instruction that triggers a one time. Use the OSR when an event must 
start as soon as the state of the rung changes from false to true, as triggered by a push button. An 
example would be to use the OSR to freeze rapidly displayed LED values. 

Place the OSR on the rung immediately before the output instruction. Then reference the output as the 
one-shot in your program. The address that you give to the OSR input instruction is where the previous 
state of the rung is retained. 

Use the bit address B3 for the OSR instruction. This address is not used for any other instruction in 
PLCMotion. 

6.2.1.2. OTE: Output Energize 

When this is true, the output will be energized. 

6.2.1.3. XIO: Examine if Open 

This instruction functions as an input or storage bit. 

If the corresponding memory bit is a “1” (on), this instruction will not allow rung continuity and any 
outputs on its rung will be de-energized. 

6.2.1.4. XIC: Examine if Closed 

This instruction functions as an input or storage bit. 

If the corresponding memory bit is a “1” (on), this instruction will allow rung continuity and outputs will 
be energized. 
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6.2.2. Computational Instructions 

6.2.2.1. ADD: Addition 

When rung conditions are true, this output instruction adds Source A to Source B and stores the result at 
the destination address.  Source A and Source B can be either values or addresses that contain values; 
however, Source A and Source B cannot both be constants. 

6.2.2.2. CLR: Clear 

This output instruction sets all the bits in a word to (0) when rung conditions are true. The destination 
must be a word address. 

6.2.2.3. DIV: Divide 

When rung conditions are true, this output instruction divides Source A by Source B and stores the result 
in the destination and the math register. The value stored in the destination is rounded. The value 
stored in the math register consists of the non-rounded quotient (placed in the most significant word) 
and the remainder (placed in the least significant word). 

Source A and Source B can be either constant values or addresses that contain values; however, Source 
A and Source B cannot both be constants. 

6.2.2.4. MUL: Multiply 

Use the MUL instruction to multiply one value (source A) by another (source B) and place the result in 
the destination. Source A and Source B can be either constant values or addresses that contain values; 
however, Source A and Source B cannot both be constants. 

6.2.2.5. NEG: Negate 

The NEG instruction changes the sign of the source and places it in the destination when rung conditions 
are true. The source and destination parameters must be word addresses. 

6.2.2.6. SUB: Subtraction 

The SUB output instruction subtracts Source B from Source A and stores the result in the destination 
when rung conditions are true. Source A and Source B can be either values or addresses that contain 
values; however, Source A and Source B cannot both be constants. 

6.2.3. Program Control Instructions 

6.2.3.1. JMP: Jump 

When the rung condition is true, the processor jumps in the program to the rung with the specified 
label. Jumping forward to a label saves program scan time by omitting a program segment until needed.  
Jumping backward lets the controller execute program segments repeatedly. 

6.2.3.2. LBL: Label 

A label marks a place in a rung as a reference for a Jump instruction. This instruction has no control bits. 
It is always evaluated as true or logic 1. 
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6.2.4. Timer and Counter Instructions 

6.2.4.1. CTD: Count Down 

This output instruction counts down for each false-to-true transition of conditions preceding it in the 
rung and produces an output when the accumulated value reaches the preset value. Rung transitions 
might be activated by a limit switch or by parts traveling past a sensor. 

6.2.4.2. CTU: Count Up 

This output instruction counts up for each false-to-true transition of conditions preceding it in the rung 
and produces an output when the accumulated value reaches the preset value. Rung transitions might 
be activated by a limit switch or by parts traveling past a sensor. 

6.2.4.3. RTO: Retentive Timer on Delay 

An RTO function is the same as a TON except that once it has begun timing, it holds its count of time 
even if the rung goes false or a fault occurs. By retaining its accumulated value, retentive timers 
measure the cumulative period during which rung conditions are true. 

6.2.4.4. TOF: Turn Off Delay 

Use the TOF instruction to turn an output on or off after its rung has been off for a preset time interval. 
This output instruction begins timing (at either one second or one hundredth of a second intervals) 
when its rung goes false. It waits the specified amount of time (as set in the PRESET), keeps track of the 
accumulated intervals which have occurred (ACCUM), and resets the DN (done) bit when the ACCUM 
(accumulated) time equals the PRESET time. 

The Accumulated value is reset when rung conditions go true regardless of whether the timer has timed 
out. 

6.2.4.5. TON: Timer on Delay 

Use the TON instruction to turn an output on or off after the timer has been on for a preset time 
interval. This output instruction begins timing (at either one second or one hundredth of a second 
intervals) when its rung goes true. It waits the specified amount of time (as set in the PRESET), keeps 
track of the accumulated intervals which have occurred (ACCUM), and sets the DN (done) bit when the 
ACCUM (accumulated) time equals the PRESET time. 

As long as rung conditions remain true, the timer adjusts its accumulated value (ACC) each evaluation 
until it reaches the preset value (PRE). The accumulated value is reset when rung conditions go false, 
regardless of whether the timer has timed out. 

6.2.5. Compare Instructions 

6.2.5.1. EQU: Equal 

This input instruction compares two sources. If Source A equals Source B the output will be true. It 
allows rung continuity if the two values are equal.  

6.2.5.2. GEQ: Greater Than or Equal To 

This input instruction compares two sources. If Source A equals or is greater than Source B it allows rung 
continuity. The rung will go true and the output will be energized. 
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6.2.5.3. GRT: Greater Than 

This input instruction compares two sources. If Source A is greater than Source B it allows rung 
continuity. The rung will go true and the output will be energized. 

6.2.5.4. LEQ: Less Than or Equal To 

This input instruction compares two sources. If Source A equals or is less than Source B it allows rung 
continuity. The rung will go true and the output will be energized. 

6.2.5.5. LES: Less Than 

This input instruction compares two sources. If Source A is less than Source B it allows rung continuity. 
The rung will go true and the output will be energized. 

6.2.5.6. MEQ: Masked Comparison for Equal 

This conditional instruction compares 16-bit data of a source address to 16-bit data at a reference 
address through a mask. If the values match, the instruction is true. This instruction allows portions of 
the data to be masked by a separate word. 

6.2.5.7. NEQ: Not Equal 

This instruction tests whether two values are not equal. Source A and Source B can be values or 
addresses. 

6.2.6. Logical Instructions 

6.2.6.1. AND 

When rung conditions are true, sources A and B of this output instruction are stored in a specified 
destination. 

Sources A and B can be either word addresses or constants; however, both sources cannot be a 
constant. The destination must be a word address. 

AND Truth Table 

SOURCE A SOURCE B DEST 

0 0 0 

0 1 0 

1 0 0 

1 1 1 
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6.2.6.2. NOT 

When rung conditions are true, the source of the NOT instruction is stored in the specified destination. 

The source and destination must be word addresses. 

NOT Truth Table 

SOURCE DEST 

0 1 

0 1 

1 0 

6.2.6.3. OR 

When rung conditions are true, Sources A and B of the OR instruction are stored in the specified 
destination. Sources A and B can be either word addresses or constants; however, both sources cannot 
be a constant.  You can enter a constant or a word address for either source parameter. The destination 
must be a word address. 

OR Truth Table 

SOURCE A SOURCE B DEST 

0 0 0 

0 1 1 

1 0 1 

1 1 1 

6.2.6.4. XOR 

When rung conditions are true, Sources A and B of the XOR instruction are Exclusive stored in the 
specified destination. Sources A and B can be either word addresses or constants; however, both 
sources cannot be a constant. 

XOR Truth Table 

SOURCE A SOURCE B DEST 

0 0 0 

0 1 1 

1 0 1 

1 1 0 
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6.2.7. Move Instructions 

6.2.7.1. MOV: Move 

When rung conditions preceding this instruction are true, the MOV instruction moves a copy of the 
source to the destination each scan. The original value remains intact and unchanged in its source 
location. 

6.2.7.2. MVM: Masked Move 

When rung conditions are true, the MVM instruction moves data from a source location to a 
destination, and allows portions of the destination data to be masked by a separate word. Data at the 
source address passes through the mask to the destination address. As long as the rung remains true, 
the instruction moves the same data each scan. 

6.2.8. Shift Register Instructions 

6.2.8.1. BSL: Bit Shift Left 

On each false-to-true transition, this output instruction loads a bit of data into a bit array, shifts the 
pattern of data through the array to the left, and unloads the end bit of data. 

An example of the use of this instruction might be for tracking bottles through a bottling line where each 
bit represents a bottle. 

6.2.8.2. BSR: Bit Shift Right 

On each false-to-true transition, this output instruction loads a bit of data into a bit array, shifts the 
pattern of data through the array to the right, and unloads the end bit of data. 
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7. Online Operation 

7.1. OVERVIEW 

The PLCMotion software is configured to work online with a PLC controller. To connect the controller to 
the PLC components, consult the manual provided with your controller. 

7.2. CONNECTING A CONTROLLER TO A PC 

7.2.1. Allen Bradley (AB) SLC 500,  MicroLogix 1000 or MicroLogix 1100 PLC 

To connect the controller to the computer: 

 Connect an RS232 cable from the RS232 port on the controller to an open COM port on the 
computer, or  

 Connect an RS232 cable from the RS232 port on the controller to an RS232 – USB adapter and 
connect the adapter to an open USB port on the computer. 

7.3. PC-CONTROLLER COMMUNICATION 

7.3.1. Configuring Communication Settings  

If there is no communication between the PC and the controller, the communication settings must be 
configured. Ensure that the TESTPLC.exe application is closed before continuing.  
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To configure the communication settings:  

1. Run SERVCFG.exe from the C:\Intelitek\PLCMotion\ folder, or from within PLC Online Control, 

select Simulate| AB PLC Configuration.   

 

2. Ensure that the correct Com Port is selected.  

If you are using a RS232 – USB adapter, identify the Com Port number from Windows Device 

Manager. 

3. Configure the Communications settings as required.  

4. Click Apply, and then Close.  

Run TESTPLC.exe as described in the steps in the Testing Communication section below to test if 
communication has been enabled between the PC and the controller.  

7.3.2. Testing Communication 

For most PCs configuration is not required in order to facilitate communication with the controller. 

To test whether the PC communicates with the PLC:  

1. Run TESTPLC.exe from the C:\Intelitek\PLCMotion\ folder. 

1. In the Data field, insert a number between 1 and 63. 

2. Click Write. 
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The number will appear in binary form in the Outputs field. 

 

If communication is successful:  

 The word “SUCCESS!” will appear in the Result field.  

 The corresponding output LEDs on the controller for the binary number will light-up.  

For example: If you insert the number 5 in the Default field, since 5 is equal to 101 in binary, the first and 
third LEDs will light-up.  

101000 =  
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If communication is unsuccessful, an error will appear in the result field (see the example error message 
in the image below). If this occurs, the PLC communication settings must be configured.  

 

IMPORTANT: If communication is successful, the controller must be returned to its default state after 
performing the test. To do so, insert the number “0” and click Write. Then close the program. 

To confirm that there is communication between the PC and the PLC: 

1. From the Start menu, select Programs | PLCMotion | PLC Simulator. 

2. Open the PLCLINE4.LAD ladder diagram (if using an AB SLC 500 controller), or PLCMLINE4.LAD (if 

using an AB MicroLogix 1000 or 1100 controller) located in the 

C:\Intelitek\PLCMotion\AB_work\Solutions\ folder. 

3. Click the On-Line  icon followed by the Simulation  icon. 

PLC Line activity should be reflected in the ladder diagram. If there is still no communication, contact 
technical support. 
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8. Software Licensing 
For information regarding software licensing, refer to the Intelitek Software Licensing Guide in the Books 
folder on the installation CD.  

 


